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Register and Publish a Blog Post
OPEN a blank document screen.
You can publish a Word document as a blog post, use a blog template, or create a new
blog. Before you can publish, you need to register for your own blog space. You will use
WordPress as your blog service provider. Create your own space at wordpress.com. The
service is free. Follow the instructions on its home page and use your live account for your
e-mail address. You identify a blog address, your user name and a strong password.
1. In Backstage, click Share, and then click Post to Blog. Because this is your first blog,
you have to go through the registration process (see Figure 13-32).

Figure 13-32
Post to Blog screen

Blogging sites

Post to Blog button.
First time users will
register for a blog account

2. Click the Post to Blog button. The Register a Blog Account dialog box opens as shown
in Figure 13-33.
Figure 13-33
Register a Blog Account
dialog box

3. Click the Register Now button, click the drop-down arrow, select WordPress, and then
click the Next button.
At the time this book was published, WordPress services were free.
4. In the New Press Account, enter a Blog Post URL. For example, http://wordwise2013.
wordpress.com/xmlrpc.php is shown in Figure 13-34 along with the confirmation that
the account registration is successful (the user name and password is hidden). Avoid
entering this URL because the domain name is already taken.
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Figure 13-34
New WordPress Account
and Account registration
successful

Enter Blog Post URL
Enter your live account
Enter a strong password

5. Enter any name you would like for your URL and once it displays as being available
complete the registration process by creating [your user name] and [your password].
(It should be a strong password—the screen will indicate if it is weak or strong.)
6. The Word screen displays [Enter Post Title Here] . Type What are your thoughts about
the NEW features in Word 2013 ? (see Figure 13-35).
In the Blog group, the Publish button contains two options: Publish and Publish as
Draft . After you complete a few more steps, you post and publish your first blog.
On the next step, you add your blog URL to your account.
Figure 13-35
New post entered
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7. On the Blog group, click the Manage Accounts button to display the Blog Accounts dialog
box as shown in Figure 13-36. Under Manage Accounts, you should see your Blog URL.
Figure 13-36

Change Blog
account

Blog Accounts

Set Blog account
as your default

Create New
Blog account

Remove
Blog account

8. If you do not see your URL, click the New button.
The New Blog Account dialog box opens.
9. Click the drop-down arrow to display the menu, select WordPress, and click Next. The
New WordPress Account dialog box opens. Enter your Blog Post URL, ,Enter your blog
URL here.; for example, wordwise2013.wordpress.com, and then enter [your user
name] and [your password] .
If you would like Word to remember your password, click the Remember Password box
to add a check mark. Another option is Picture Options . When you publish your blog
post, your picture needs to be uploaded to a picture provider on its storage location.
Options to consider if you decide to upload a picture include: You can upload to My
blog provider, My own server, and None— don’t upload pictures. For this exercise, do
not use the Picture Options .
10. After entering [your blog post URL] , [your user name], and [your password] , a prompt
appears stating, When Word sends information to the blog service provider, it may be
possible for other people to see that information. This includes your user name and
password. Do you want to continue? Click Yes.
11. Click the Manage Accounts button again in the Blog group to see your account shown
in Figure 13-36. Click Close.
12. Click the Publish button on Blog group to display the Connect to [your Blog URL] dialog
box. Figure 13-37 displays Connect to wordwise2013 . Type [your user name] and [your
password] to post and publish.
13. A prompt appears stating, When Word sends information to the blog service provider,
it may be possible for other people to see that information. This includes your user
name and password. Do you want to continue? Click Yes.
Figure 13-37
Connect to wordwise2013

Enter your User Name
Enter your password

A gray prompt appears in your Word blog document screen stating, This post was
published to ,your blog URL site. followed by the time and date; for example, This
post was published to wordwise2013 at 7:13:49 PM 1/ 21/2013.
14. When you click the Home Page
button on the Blog group, it automatically connects
the Internet directly to your Blog URL website after you have logged in.

Take Note

You can blog and publish from your blog URL site.
15. The Insert Category button allows you to categorize postings on your blog. When you
click on this button, you are prompted to log in again. When you categorize your blog
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post, you can select from the drop-down menu. In the meantime, you do not see any
category. If you clicked on the Insert Category button, click the Undo button on the
Quick Access Toolbar to remove. The Open Existing button opens a published blog.
16. CLOSE the blog post. A prompt might appear stating, Do you want to save changes
made to the document? If you click “Don’t Save,” a recent copy of this file will be
temporarily available. Click Save. Use the default name and save to your lesson folder
on your flash drive.
PAUSE. LEAVE Word open for the next exercise.

STEP BY STEP

Publish a Word Document as a Blog
GET READY. OPEN Word if it is not already running.
1. OPEN the Employment Offer 20XX document from the lesson folder. You are now
ready to publish an existing Word document as a blog.
2. Go to Backstage, and click Share. Click Post to Blog, and then click the Post to Blog
button. The Employment Offer 20XX document is inserted in the Word Blog layout and
appears below the horizontal line.
3. Click the Publish button in the Blog group to display Connect to ,your Blog URL site.,
Connect to wordwise2013 . Enter your user name and password, and then click OK .
4. A prompt appears stating, When Word sends information to the blog service provider,
it may be possible for other people to see that information. This includes your user
name and password. Do you want to continue? Click Yes.
5. A gray prompt appears on the screen stating, This post was published to your ,Blog
URL site. at time is displayed and date.
6. SAVE the blog post with the default name in the lesson folder on your flash drive.
7. CLOSE the Employment O ffer 20XX document.
PAUSE. CLOSE Word.

STEP BY STEP

Remove a Blog on Your Blog Site
GET READY. OPEN Word if it is not already running.
1. LAUNCH your Internet browser and log in to your WordPress 2013 blog. On the left side
of the screen, click Post, and then click All Posts.
2. Add a check mark in the check box, and then select Trash.
3. Log out of your blog URL site.
Have fun blogging!
CLOSE the Internet.

SKILL SUMMARY
Objective
Number

In this lesson you learned to:

Exam Objective

Protecting and Sharing
Documents

Protect documents with
passwords.

1.5.5

Save files to remote locations.

1.5.4

Managing Document Versions
Sharing Documents
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Knowledge Assessment

True/False
Circle T if the statement is true or F if the statement is false.

T F

1. You can specify two different passwords, one to open a document and one to
modify it.

T F

2. You should run the Compatibility Checker on all document files.

T F

3. The Compatibility Checker ensures that the document’s features are compatible
with other versions of Word.

T F

4. When you restore an earlier version of your document, the AutoSave Version
prompt will appear in as yellow bar, alerting you that a newer version is
available. As a user, you have the option to compare and restore.

T F

5. The Compatibility Checker lists a summary of features not supported by
earlier versions.

T F

6. Using SkyDrive is another way to share documents.

T F

7. Formatting restrictions allow users to limit the formatting styles in a
document.

T F

8. Read only prevents changes to a document.

T F

9. Inspect Document does not provide options on removing features that might
have been used in the document.

T F 10. The Restrict Formatting and Editing pane cannot be accessed on the
Ribbon.

Multiple Choice
Select the best response for the following statements.

1. Requiring a password to open a document is accomplished by using:
a. Encrypt with Password.
b. Restrict Editing.
c. Restrict Formatting.
d. Word does not support this feature.
2. A document that is protected from editing, but allows comments is protected using
which feature?
a. Restrict Formatting
b. Protected from using comments
c. Comments features was turned off
d. Editing Restrictions
3. Unsaved documents can be recovered using:
a. multiple users.
b. Manage Versions.
c. SkyDrive.
d. Save As.
4. Internet faxing is available to users:
a. at no charge.
b. for a fee by service providers.
c. only if you have access to a fax machine.
d. It is not available.
5. Word provides blogging as an option, but as a user you must:
a. register a blog URL.
b. post and publish.
c. maintain your blog URL site.
d. All of the above
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6. You must register a Blog space before:
a. blogging.
b. posting a blog.
c. sharing.
d. publishing.
7. If your document contains potential problems where the content is difficult to read by
an individual with a disability, you would be alerted under which command?
a. Check Accessibility
b. Check Compatibility
c. Inspect Document
d. All of the above
8. Before sharing a document, it is good practice to remove personal information using
which command?
a. Check Accessibility
b. Check Compatibility
c. Inspect Document
d. No command is available.
9. Draft versions of documents can be deleted by:
a. right-clicking, and then selecting Delete.
b. using Manage Versions.
c. pressing the Delete key.
d. a and b
10. Recovering unsaved documents is located under which command?
a. Info
b. Recent
c. Open
d. Save & Send

Proficiency Assessment
Project 13-1: Formatting the Coffee Menu
Your manager has asked you to format the coffee menu document appropriately and have it ready
for a meeting in an hour.
GET READY. LAUNCH Word if not already running.
1. OPEN Coffee Menu document from the lesson folder.
2. Go to Backstage, click Options, and then Save.
3. Under the Save section, by Save AutoRecover information every, change to 3 minutes.
4. Select the heading Grand Street Coffee Shop.
5. Change the font color and select Purple, Accent 4, Lighter 80% .
6. Change the page border with a shadow style with the border color of Purple, 4 ½0 wide.
7. Select Menu, italicize, bold, and change the font size to 26 pts.
8. Change the font to Cambria and color to Purple, Accent 4, Darker 50% .
9. Select Menu and use the Format Painter and apply to Nutritional Information.
10. Apply a page color, and select Purple, Accent 4, Lighter 80% .
11. CLOSE the document without saving. A prompt should appear on your screen: If you
don’t save, a recent copy of the document will be temporarily available. If the prompt
did not appear, check step 2. Click Don’t Save. In the next exercise, you recover your
unsaved document.
LEAVE Word open for the next project.
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Project 13-2: Managing Versions
You are continuing with the previous project and realized that you inadvertently didn’t save the
document. Your task is to retrieve the unsaved document.
GET READY. LAUNCH Word if not already running.
1. Go to Backstage, click the Manage Versions button.
2. Select Recover Unsaved Documents.
3. Locate the file and click Open and click Restore.
4. SAVE the document as 13-2 Coffee Menu in the lesson folder on your flash drive, and
then CLOSE the file.
LEAVE Word open for the next project.

Competency Assessment
Project 13-3: Posting the Coffee Menu for Review
You are ready to post your new menu to your class for review. Inspect the document and mark it
as final.
GET READY. LAUNCH Word if not already running.
1. OPEN 13-2 Coffee Menu from the lesson folder.
2. SAVE the document as 13-3 Coffee Menu for Review in the lesson folder on your flash
drive.
3. Open Backstage, select Check for Issues, and then select Inspect Document.
4. Click Inspect the document and click Remove All by the Document Properties and
Personal Information section.
5. Click Close.
6. Click Allow this information to be saved in your file.
7. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
LEAVE Word open for the next project.

Project 13-4: Encrypting Relocation Proposal with a Password
Your task is to remove all document properties in the stock agreement document before sharing
with eligible employees.
GET READY. LAUNCH Word if not already running.
1. OPEN Relocation Proposal document from the lesson folder.
2. SAVE the document as 13-4 Relocation Proposal in the lesson folder on your flash
drive.
3. Inspect the document.
4. Click Remove A ll on the Document Properties and Personal Information setting and
Headers, Footers, and Watermarks setting.
5. Click Close.
6. Encrypt the document with a password and enter BYA%$#agree.
7. SAVE the document in the lesson folder on your flash drive.
LEAVE the document open for the next project.
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Mastery Assessment
Project 13-5: Saving Relocation Proposal to SkyDrive
You have finalized the relocation proposal document and are ready to share it with employees from
around the region. Your task is to save the document and create a shared link for everyone to view.
GET READY. LAUNCH Word if not already running.
1. OPEN the Relocation Proposal document from the lesson folder.
2. SAVE the document as 13-5 Relocation Proposal in the lesson folder on your flash
drive.
3. Invite five students from class and include your instructor.
4. Type in the message box, This is the first draft for the relocation proposal. Sign with
your name, and then Share.
5. CLOSE the file.
LEAVE Word open for the next project.

Project 13-6: Creating a Document with a Password
Create a document that only you can access.
GET READY. LAUNCH Word if not already running.
1. SAVE the document as Password in the lesson folder on your flash drive.
2. Type the following:
Name: Giovanni
E-mail address: someone@live.com
The importance of using a password:
Unauthorized access to your document
A password added to documents prevents unwanted changes
The document can only be opened by those who know the password
3. Apply the default numbering format to the previous three items.
4. Protect the document by securing it with the following password, and type dap&27#% .
Use the same password to open and modify the document.
5. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
CLOSE Word.
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LESSON SKILL MATRIX
Skill

Exam Objective

Objective Number

Customizing Word

KEY TERMS
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• metadata
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You are employed as a researcher at A Datum Corporation, a company
that provides custom consulting services to information technology companies. Many of the default options for Word are suitable, but there are
times you need to make changes to settings for features such as compatibility, editing, printing, and saving. In this lesson, you learn how to access
options that enable you to customize Word to best fit the tasks that you
perform such as changing display options, setting save options, using advanced options, customizing the Quick Access Toolbar, and customizing
the Ribbon.

© GlobalStock/iStockphoto

SOFTWARE ORIENTATION
Word Options
The Word Options dialog box provides a wide variety of methods to customize how Word is
used. Ten different option categories are provided. To access these options, click the File tab
and then click Options as shown in Figure 14-1.
Check mark indicates feature
is enabled. These are the defaults

Word
Options
features by
category

By default,
ScreenTips
are on but
can be turned off

Add User name
and initials

The Office Background
will appear when you
sign in with your
Microsoft Account.
Options are available
to change the background
to clouds, circuit, tree
rings and much more
Option to change theme

Figure 14-1
Word Options dialog box with General settings displayed

Use this figure as a reference throughout this lesson as well as the rest of this book.
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CUSTOMIZING WORD
The Bottom Line

Word can be customized through the different options available in the Word Options dialog box.

Personalizing Word
In previous lessons, you open the Word Options dialog box in Backstage and change the default
settings. The General settings contain some of the most frequently used options that can be customized in Word, including options to personalize Word, such as changing the user name and
initials. Take time to explore the contents of each screen. The more familiar you become with the
options available, the better able you will be to customize Word to suit your needs. In this exercise,
you learn to personalize Word and add information in Properties.

STEP BY STEP

Personalize Word
GET READY. Before you begin these steps, be sure to LAUNCH Microsoft Word.
1. OPEN the A Datum document from the lesson folder.
2. Click the File tab, and then click Options to display the Word Options dialog box.
The General settings are already displayed (refer to Figure 14-1).
3. In the Personalize your copy of Microsoft Office section, type [your name] in the User
name box and [your initials] in the Initials box. Your name and initials appear only here.

Cross
Ref

In Lesson 9, you learn to change a user’s name in the Track Changes Options dialog box.
4. Click OK .
5. Open Backstage and notice the Properties pane on the right side.
This pane displays the properties of the document size, pages, words, editing time,
date the document was created or modified, and author and any other person who
might have reviewed the document.
6. Display the Advanced Properties by clicking the drop-down arrow under Properties,
and then select Advanced Properties. The Advanced Properties dialog box opens as
shown in Figure 14-2.

Figure 14-2
Properties dialog box
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Cross
Ref

In Lesson 2, you learn to display the Document Panel to show above the document and open the
Advanced Properties. You can also display the Advanced Properties from Backstage.
7. Click the Summary tab to add information that describes your document.
Data that describes other data is called metadata. Information in the properties is also
known as metadata, which includes details about the document.
8. Type the information as shown in Figure 14-3, and then click OK .

Figure 14-3
A Datum Properties
Summary tab

9. Select Show All Properties at the bottom of the Properties pane.
Review the updated properties in Backstage to see the author’s name and tags.
10. Return to the document.
PAUSE. LEAVE the document open to use in the next exercise.

Changing Display Options
The Display screen of the Word Options dialog box contains options for changing how document
content is displayed both on the screen and when printed. Changing these options affects all documents, not just the document that is currently open. Select or deselect the check box for any
option you want to turn on or off. Many of these options stay in this state for all Word documents
until you change them again. In this exercise, you learn to change the display options.

STEP BY STEP

Change Display Options
USE the document that is open from the previous exercise.
1. Click the File tab, and then click Options to display the Word Options dialog box.
2. Click Display to view the display options, shown in Figure 14-4.

Using Advanced Options

463

Figure 14-4
Display options screen

Show top and bottom margins,
include headers and footers

Show all Formatting marks is off
by default. Click the check box to
add a check mark to enable
Print without graphics or
floating text boxes

In the Always show these formatting marks on the screen section, the check box is
empty beside the Show all formatting marks .
3. Click to add a check mark next to Show all formatting marks.
4. Click OK .
Notice that the paragraph marks appear in the document.
5. Open the Display screen and click to remove the check mark by Show all formatting
marks. By default, this feature is disabled.
6. Click OK .
7. CLOSE the document without saving.
PAUSE. LEAVE Word open to use in the next exercise.

Turning AutoFormat Off or On
When AutoFormat As You Type options are turned on, Word allows you to apply formatting quickly as you type bullets and number lists, fractions, numbers, borders, ordinals, and hyphenate text.
Other options that you have available are Apply as you type and Automatically as you type. When the
automatic formatting has been applied, you can undo the changes by using the AutoCorrect
Options button in the AutoCorrect dialog box. In this exercise, you learn how to turn off certain
features using the AutoCorrect Options button.
You can access AutoFormat As You Type by opening the Word Options dialog box and selecting
Proofing. Then open the AutoCorrect dialog box. Tables 14-1, 14-2, and 14-3 provide a description
of what will occur after each specified action has been performed.
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Table 14-1

Replace as you type

Description

"Straight quotes" with “smart
quotes”

Straight quotations marks (" ") and straight apostrophes ( ' ) are
replaced with curved, open, and closed quotations marks (“ ”)
and curved apostrophes.

Fractions (1/2) with fraction
character (½)

When you type “1/2”, it is replaced with ½. This option only
replaces ¼, ½, and ¾.

*Bold* and _italic_ with real
formatting

The bold element will be applied when text begins and ends with
an asterisk ( * ). The italic element is applied to text beginning
and ending with an underscore ( _ ). For example,
*AutoFormat* becomes AutoFormat and _text_ becomes
text. By default, this feature is off and must be enabled before
using.

Internet and networks paths with
hyperlinks

Word automatically recognizes when an Internet address,
network path, and e-mail address are typed and will automatically
replace these with hyperlinks.

Ordinals (1st) with superscript

Order set of sequence numbers. For example, 1st, 2nd, and 3rd.

Hyphens (--) with em dash (—)

Replaces two hyphens typed sequentially with an em dash
( — ); a single hyphen with a space before and after ( - ) will be
replaced with an en dash (–).

AutoFormat As You Type

Table 14-2

Apply as you type

Description

Automatic bulleted lists

When typing one of these characters *, -, . followed by a space or tab,
a bulleted list will be created.

Border lines

When you type three consecutive characters (~, #, *, -, _, or 5) on a
new line and then press Enter, a line with that character will appear
across the page.

Built-in Heading styles

When fewer than five words are used in headings and the Enter key is
pressed twice, the built-in heading style will be applied. For each new
heading that you type, a new line is followed by the Tab. For example,
Heading 1, type a line; for Heading 2, press Tab; Heading 3 press Tab twice.

Automatic numbered lists

When you begin a numbered list and type the number 1 followed by a
period or tab, a numbered list is created.

Tables

A single row of a table is created when you type 1-----1-----1----1-----1
and then press the Enter key. Four columns and one row are created. The
number of hyphens between the plus symbols is the column width.

Apply as you type

Table 14-3

Automatically as you type

Description

Format beginning of list item like
the one before it

Formats the beginning text of a list item like the previous list.

Set left- and first-indent with
tabs and backspaces

Indent the first line of a paragraph by putting the cursor before the
first line, and then press the Tab key. Indent the whole paragraph
by putting the cursor before any line in the paragraph with the
exception of the first line and then press Tab. Place insertion point
before the first line, and then press the Backspace key to remove.

Define styles based on your
formatting

When text has been formatted manually, the same style will be
applied when the Enter key is pressed.

Automatically as you type

Using Advanced Options
STEP BY STEP

465

Turn AutoFormat Off or On
OPEN the A Datum Security Alarm document from the lesson folder.
1. Click the File tab, and then click Options.
2. Click Proofing to display the options.
3. Click the AutoCorrect Options button, and then click the AutoFormat As You Type tab.
4. Under the Apply as you type section, select the check box by Automatic bulleted lists
to clear it (an empty check mark indicates the feature is off).
5. Click again to place a check mark in the box to turn Automatic bulleted lists back on
(see Figure 14-5).

Figure 14-5
AutoCorrect dialog box
displaying the AutoFormat As
You Type tab
AutoFormat As You Type tab is active

An empty check box
indicates feature is off

A check mark indicates
feature is on

6. Click OK to close the AutoCorrect dialog box, and then click OK to close the Word
Options dialog box.
7. Position the insertion point after the last bulleted item and press Enter twice to move
to the next line and clear the added bullet.
8. On the Page Layout tab, in the Page Setup group, select Continuous from the Line
Numbers command, and then place the insertion point on line 14.
9. Type ~ ~ ~ three times and press Enter.
A wavy border line is placed across the page.
10. Access the Proofing settings in the Word Options dialog box and click the AutoCorrect
Options button.
11. Add a check mark by *Bold* and _italic_ with real formatting to enable this feature.
12. Click OK two times to close both dialog boxes.
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13. On line 26, select Ready and type *Ready*. The text is automatically bolded.
14. In the AutoCorrect Options, remove the check mark by *Bold* and _italic_ with
real formatting.
15. SAVE the document as Security Alarm Update in the lesson folder on your flash drive,
and then CLOSE the file.
PAUSE. LEAVE Word open to use in the next exercise.

Cross
Ref

In Lesson 9, you learn about accessing the AutoCorrect Options.

Setting Save Options
The Save screen of the Word Options dialog box contains options for customizing how documents
are saved, including preserving information in backup files for your documents, sharing files using
a document management server, and embedding fonts in a file. For example, you can change the
default format used to save documents, or you can change how often your documents are backed
up by using AutoRecover. The Documents folder, located on drive C, is the default working folder for all the documents created in Microsoft Office programs. A yellow folder appears on the
taskbar and directly takes you to the default settings for your folders and files. On the Save screen,
you can choose a different default working folder (for example, your flash drive). In this exercise,
you learn to change and set save options.

STEP BY STEP

Set Save Options
OPEN a blank document.
1. Click the File tab, and then click Options.
2. Click Save to display the Save options screen as shown in Figure 14-6.

Figure 14-6
Save options screen
On by default

Document is saved in this format — default settings

Default AutoRecovery
setting is 10 minutes

Location where files
can be recovered
Location where files
are saved

Saves fonts
within the document,
ensuring anyone
can view and use
your fonts
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3. In the Save documents section, click the drop-down arrow in the Save files in this
format box.
The menu displays the options available for changing the default file format used when
saving backup files. The default setting to save your work is set to every 10 minutes.
4. In the Save AutoRecover information every box, change the setting to 3.
Your documents will be saved every three minutes. Check with your instructor before
changing the settings. If you change the settings, don’t forget to return the setting back
to its default.
5. LEAVE the Word Options dialog box open for the next exercise.
PAUSE. LEAVE Word open to use in the next exercise.

Take Note

Any change made to the default working folder applies only to the application that you are currently using. For example, if a different default working folder is selected for Word, the default
working folder for Excel remains Documents if you are using Windows 8 or Windows 7.

Using Advanced Options
The Advanced screen in the Word Options dialog box contains many complex choices for working with Word documents, including options for editing, displaying, printing, and saving. There
are many options available but the Advanced screen contains the majority of options. Some are
selected by default and some are not. Browse through them to see how you might use some of the
options to work more efficiently in Word. In addition to the multitude of options found on this
screen, several dialog boxes can be accessed for additional customization. In this exercise, you
learn to use the advanced options.

STEP BY STEP

Use Advanced Options
USE the document open from the previous exercise.
1. From the Word Options dialog box, click Advanced to display the Advanced options.
There are several advanced options, many of which are shown in Figures 14-7
through 14-10.
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Figure 14-7
Advanced options screen;
Editing options

Use the scroll bar to
view additional options

Option to change
and update the style

2. Scroll down and locate the Display section (shown in Figure 14-8); click the down arrow
next to the number in the Show this number of Recent Documents list box to change it
from 25 to 10.
Figure 14-8
Advanced options screen;
Display and Print options

Recent Documents
display default setting
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3. Click OK .
4. Click the File tab, and then click Open. Ten documents display under Recent
Documents .
5. Return the settings back to default, and leave the Word Options dialog box open.
6. Scroll down to the Save section (shown in Figure 14-9) and click the check box to
enable Prompt before saving Normal template. Now if you change the default
template, Word will prompt you if you want to save the changes to that template.
Figure 14-9
Advanced options screen;
Print and Save options

If the default
template is changed,
Word will ask if
you want to
save changes

7. Scroll down to the General section (shown in Figure 14-10) and type [your name and
address] in the Mailing address box.
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Figure 14-10
Advanced options screen;
General options

Adding your address
here will automatically
place it in the return
address field when
creating envelopes or labels

Layout options
for current
document

8. Click OK .
9. Open a blank document.

Another Way
The keyboard
shortcut Ctrl1N opens a new
blank document.

10. On the Mailings tab, in the Create group, click the Envelopes button.
In the Envelopes and Labels dialog box, notice that your name and address appear in
the Return address area.
11. Click Cancel.
12. Return to the General section of the Advanced settings and remove your name and
address, and then remove the check mark by Prompt before saving Normal template
under the Save section. Click OK.
PAUSE. LEAVE Word open to use in the next exercise.

Customizing the Quick Access Toolbar and Ribbon
The Customize Ribbon and Quick Access Toolbar screens enable you to customize the Quick Access
Toolbar, the Ribbon, and keyboard shortcuts. Adding frequently used commands to the Quick Access Toolbar ensures that those commands are always just a single click away. Only commands can be
added to the Quick Access Toolbar. The contents of most lists, such as indent and spacing values and
individual styles, which also appear on the Ribbon, cannot be added to the Quick Access Toolbar. In
this exercise, you add commands to the Quick Access Toolbar, customize a keyboard shortcut, and
customize the Ribbon.

STEP BY STEP

Customize the Quick Access Toolbar
USE the document open from the previous exercise.
1. Click the File tab, and then click Options.
2. Click Quick Access Toolbar in the left pane to display the customization options, shown
in Figure 14-11.
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Figure 14-11
Word Options; Custom the
Quick Access Toolbar settings
Click to change command category

New commands
added to the
Quick Access
Toolbar will
appear here
Popular
commands

Add and Remove buttons

Cross
Ref

You first learn about the Quick Access Toolbar in Lesson 1.
In the Choose commands from list, Popular Commands is already selected.
3. Scroll down the list of commands, select Page Setup, and then click the
Add button.
4. Select Page Width, and then double-click to quickly add to the Customize Quick Access
Toolbar list. Repeat the step for the Numbering command.

Another Way
You can open the
customization screen using the
Customize Quick Access
Toolbar, More Commands menu
option.

Take Note

STEP BY STEP

5. Click OK . The Quick Access Toolbar is now customized with new commands that are
easily accessible. Check with your instructor to see if these commands should remain
on the toolbar.
PAUSE. LEAVE Word open to use in the next exercise.

To remove a command from the Quick Access Toolbar, place the mouse pointer on the command in the Quick Access Toolbar, right-click the command, and then click Remove from Quick
Access Toolbar.

Customize the Keyboard
USE the document open from the previous exercise.
1. Open the Word Options dialog box, and click Customize Ribbon to open the
customization screen (see Figure 14-12).
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Figure 14-12

Click to change
command category

Word Options dialog box;
Customize the Ribbon and
keyboard shortcuts

Customize the Ribbon

Popular commands

Keyboard shortcuts
Customize button

Add and Remove
buttons

2. On the bottom left, click the Customize button next to Keyboard shortcuts .
The Customize Keyboard dialog box appears, as shown in Figure 14-13.
Figure 14-13
Customize Keyboard
dialog box

Category listing

Existing keyboard
shortcut (if any exists)

Commands

New keyboard
shortcut
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3. In the Categories box, click Home Tab.
You should see Bold highlighted under the Commands box.
Two shortcut key command appears in the Current keys box. The Ctrl1B shortcut is a
reserved key and assigned to the Bold command. The Ctrl+Shift+B shortcut is also
assigned to the Bold command.
4. In the Current Keys box, select Ctrl+Shift+B and then click Remove.

Figure 14-14

5. In the Press new shortcut key box, type Ctrl1Shift1U as shown in Figure 14-14. Under
the Current keys box, it shows that this command is [unassigned] .

Customize Keyboard dialog
box showing shortcut keys are
unassigned

Checks if keyboard shortcut
is already assigned

Ctrl+Shift+U is not assigned
to any command

Assign button

Remove button is dimmed
because a command
must be selected

6. Click the Assign button.
7. Return to the Word document and type any word, and then select the word and press
Ctrl1Shift1U. The text should be underlined.
8. Open the Customize Keyboard dialog box, and then select Home Tab. The two shortcut
key commands appear in the Current keys box.

Another Way
You can also add
an item to the Quick Access
Toolbar by clicking the
Customize Quick Access
Toolbar button or by
right-clicking anywhere
on the Quick Access Toolbar.

9. Select Ctrl1Shift1U, and then click the Remove button to remove the shortcut key.
Removing Ctrl1Shift1U now makes it available to be used for another shortcut
keyboard command.
10. Click Close to close the Customize Keyboard dialog box.
11. Leave the Word Options dialog box open for the next exercise.
PAUSE. LEAVE Word open to use in the next exercise.
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STEP BY STEP

Customize the Ribbon
In this exercise, you create a customized Ribbon tab and place your favorite commands in
one group on a new tab. You can add commands already found on other tabs, and you also
have the option to place commands not found in any of the tabs.
USE the document open from the previous exercise.
1. Access Word Options, and then click Customize Ribbon to open the customization
screen (see Figure 14-15).

Figure 14-15
Customize the Ribbon and
keyboard shortcuts screen

Under Main Tabs
are the default tabs

Rename button
New Group button

New Tab button

Resets all customization

2. Under Main Tabs , click the minus (2) sign to collapse the groups listed under Home, if
necessary. The Home tab should appear selected.
3. Click the New Tab button. Two objects appear: one is identified for the new tab
whereas the other is for the group as shown in Figure 14-16.
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Figure 14-16
New Tab and New Group

New Tab and New Group
appears below the Home tab

4. Select New Tab (Custom) , and then click the Rename button.
The Rename dialog box appears.
5. Type My Favorites in the Display name box (see Figure 14-17).

Figure 14-17
Rename dialog box

6. Click OK .
7. Select New Group (Custom) , and then click the Rename button.
The Rename dialog box appears with icons to identify your command group.
8. Type My Commands in the Display name box.
9. Select the smiley face.
10. Click OK .
With My Commands selected under Main Tabs , you are ready to add commands to this
group.
11. Under the Popular Commands , select then click the Add button to place in
My Commands .
12. Select Accept and Move to Next, and then click the Add button.
This command is placed under My Commands .
13. Select Breaks and Draw Table separately, and then click the Add button. Your screen
should match Figure 14-18.
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Figure 14-18
Commands added to My
Commands group

Custom tab and group

14. Click OK .
15. Click the My Favorites tab and review your customized tab and group of commands
(see Figure 14-19).

Figure 14-19
My Favorites tab on Ribbon

16. To remove the customized tab, return to the customization screen, and then click the
Reset All Customizations button. Select Yes to confirm, and click OK.
STOP. CLOSE Word.

SKILL SUMMARY
In this lesson you learned to:
Customize Word

Exam Objective

Objective Number
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Knowledge Assessment

Multiple Choice
Select the best response for the following statements.

1. To assign a new keyboard shortcut, you would access Backstage, Word Options, and then:
a. Customize Quick Access Toolbar.
b. Customize Backstage button.
c. Customize Ribbon, New Keyboard commands.
d. Customize Ribbon, Keyboard shortcuts, and the Customize button.
2. Which tab would you click to display the Options command?
a. Insert
b. Advanced
c. File
d. Display
3. The shortcut key, Ctrl1C, is:
a. unassigned.
b. accessible.
c. assigned.
d. not a shortcut key.
4. The Display screen in the Word Options dialog box displays which hidden formatting
marks?
a. Spaces
b. Tab characters
c. Paragraph marks
d. All of the above
5. The Quick Access Toolbar is for:
a. frequently used commands.
b. commands from the File menu.
c. contents of lists on the Ribbon.
d. recently used documents.
6. A check mark displayed in the Word Options dialog box, indicates the feature is:
a. off.
b. not available.
c. disabled.
d. on.
7. As a user of Word, you can change the AutoRecover minutes to set how Word protects
you from losing your work in which screen of the Word Options dialog box?
a. Save
b. Options, Save
c. Save As
d. None of the above
8. Where would you place a customized command?
a. Ribbon
b. Quick Access Toolbar
c. Does not appear
d. A new Ribbon
9. Changes made in the Word Options dialog box will affect:
a. only new documents.
b. all documents.
c. only documents opened as a template.
d. a and c
10. To locate where files are automatically saved, you would find this setting on which
screen of the Word Options dialog box:
a. General
b. Save
c. Proofing
d. Advanced
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True/False
Circle T if the statement is true or F if the statement is false.

T F

1. The Advanced screen contains the largest number of options available in the
Word Options dialog box.

T F

2. The Quick Access Toolbar and keyboard shortcuts cannot be customized.

T F

3. When creating keyboard shortcuts, Word informs you when shortcut keys have
been assigned.

T F

4. In the Word Options dialog box, you can add your name and initials under the
Personalize your copy of Microsoft Office section.

T F

5. The default settings in the Word Options dialog box cannot be changed.

T F

6. When customizing the Ribbon, you cannot add the same commands to a new
tab if they are listed on another Ribbon tab.

T F

7. Changing the Display options affects how content appears on your computer.

T F

8. When you personalize Word by adding your name to the User Name box, the
Document Properties panel will display your name in the Author box.

T F

9. The formatting marks can be turned off in the Display screen of the Word
Options dialog box.

T F 10. When customizing the Ribbon, you have the option to group commands within
a tab.

Competency Assessment
Project 14-1: Creating a Default Return Address for Lost Art Photos
In your position as a marketing assistant at LostArt Photos, you frequently mail promotional letters. You prepare envelopes for these mailings in Word, and making the company’s return address
your default option would save time. Change your Word options to set this up.
GET READY. LAUNCH Word if it is not already running.
1. OPEN a blank new document.
2. SAVE the document as 14-1 Mailing Address in the lesson folder on your flash drive.
3. Click the File tab, and then select Options to display the Word Options dialog box.
4. Click Advanced in the left pane to display the advanced options.
5. Scroll down to the General section, and in the Mailing address box, type:
LostArtPhotos
5500 Bissell Street
Grand Junction, CO 98445
6. Press the Print Scrn button on the keyboard.
7. Click OK to close the Word Options dialog box.
8. Right-click in the document screen, and then click Paste.
9. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
LEAVE Word open for the next project.

Project 14-2: Setting Research Options
A Datum Corporation has an overseas branch in the United Kingdom. In your position as a
researcher, you need content to stand out in your document. You will change the settings to turn
on the feature that will allow real formatting as you type.
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GET READY. LAUNCH Word if it is not already running.
1. OPEN a blank document.
2. SAVE your document as 14-2 Changing Settings in the lesson folder on your flash
drive.
3. Click the File tab, and then click Options.
4. Click Proofing, and then click the AutoCorrect Options button.
5. Select the AutoFormat As You Type tab, and add a check mark by *Bold* and _italic_
with real formatting.
6. Click OK to close the dialog box.
7. Click OK again.
8. Type *United Kingdom*. Press Enter.
9. Type the underscore three times, and then press Enter.
10. Remove the check mark by *Bold* and _italic_ with real formatting.
11. Click OK twice to close the dialog boxes.
12. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
LEAVE Word open for the next project.

Proficiency Assessment
Project 14-3: Customizing the Quick Access Toolbar
As a paralegal in a busy legal practice, you are always looking for ways to streamline your work.
As you learn more about Word, you want to use the available options to help customize the
program for your daily tasks.
GET READY. LAUNCH Word if it is not already running.
1. Press Ctrl1N to open a new blank document.
2. SAVE the document as 14-3 Customizing QAT in the lesson folder on your flash drive.
3. OPEN the Word Options dialog box.
4. Display the customization screen for the Quick Access Toolbar.
5. Choose five commands that you use frequently, but that are not currently located on
the Quick Access Toolbar. Add the commands to the Quick Access Toolbar.
6. Click OK to close the Word Options dialog box.
7. Press the Print Scrn button on the keyboard.
8. Right-click in the document, and then click Paste.
9. Crop and enlarge the image to show the Quick Access Toolbar.
10. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
LEAVE Word open for the next project.

Project 14-4: Removing Commands from the Quick Access Toolbar
You are continuing to work with customized Quick Access Toolbar from Project 14-3. Now that
you have added five additional commands to your Quick Access Toolbar, you realize you no longer
need these commands. You remember seeing the Remove button below the Add button in the
customization screen.
GET READY. LAUNCH Word if it is not already running.
1. SAVE a new blank document as 14-4 Removing Commands in the lesson folder on
your flash drive.
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2. Display the customization screen for the Quick Access Toolbar.
3. Remove all commands that you added to the Quick Access Toolbar and close all open
dialog boxes.
4. Press the Print Scrn button on the keyboard.
5. Right-click in the document and then click Paste.
6. Crop and enlarge the image to show the Quick Access Toolbar.
7. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
LEAVE Word open for the next project.

Mastery Assessment
Project 14-5: Saving Settings
Your instructor has asked you to change the Save AutoRecover setting to five minutes and provide
a copy of your screen shot.
GET READY. LAUNCH Word if it is not already running.
1. SAVE a new blank document as 14-5 Save Settings in your flash drive in the lesson
folder.
2. Open the Word Options dialog box and change the Save AutoRecover setting to
5 minutes.
3. Press the Print Scrn button on the keyboard, click OK, and then right-click in the
document and click Paste. This will capture your screen as an image.
4. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
LEAVE Word open for the next project.

Project 14-6: Word Options
Your task is to remove the LostArt Photos mailing address that you added in Project 14-1. To show
your instructor that you completed this project, provide a copy of your screen shot and save as a
Word document.
GET READY. LAUNCH Word if it is not already running.
1. SAVE a new blank document as 14-6 Address Removed in your lesson folder on your
flash drive.
2. Remove the mailing address.
3. Press the Print Scrn button on the keyboard, click OK, and then right-click in the
document and click Paste. This will capture your screen as an image.
4. SAVE the document in the lesson folder on your flash drive, and then CLOSE the file.
CLOSE Word.
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Project 1: Preparing the Speaker Letter
Now that you incorporated the changes suggested, prepare the document for distribution.
GET READY. LAUNCH Word if it is not already running.
1. OPEN Speaker Thank You from the data files for this lesson.
2. Inspect the document and remove all document properties and personal information
and Headers, Footers, and Watermarks.
3. SAVE the document as Inspected Document with Password in the lesson folder on
you flash.
4. SAVE the document with an encrypted password and type nap#5^% .
5. SAVE the document in the lesson folder in your flash drive, and then CLOSE the file.
PAUSE. LEAVE Word open for the next project.

Project 2: Master and Subdocument for Research Paper
You are taking a computer class this semester and have been assigned a group project. The research
project needs to be divided into sections so that you and your group members can work separately
on the document.
GET READY. LAUNCH Word if it is not already running.
1. OPEN the Research document from the lesson folder.
2. Create a new folder named Master Research in your lesson folder on your flash drive.
3. SAVE the document as Master Research in the Master Research folder.
4. Select each heading in the document beginning with Introduction and apply the
Heading 1 style.
5. Modify the Heading 1 style and change the spacing before to 12 pt and apply only to
the document.
6. Change the view to Outline.
7. In the Outline Tools, click the drop-down arrow at Show Level and select Level 1.
8. In the Master Document group, click Show Document .
9. Select the plus (1) symbol by Introduction to select.
10. In the Master Document group, click the Create button. Introduction is surrounded by a
border.
11. Repeat your steps for the remaining headings in the document, Community in the
Classroom, Technology within Literature Circles , Computer-Mediated Discussion
Groups , and Conclusion .
12. SAVE the document and CLOSE .
13. OPEN the Master Research document—the subdocuments are linked.
14. Press the Ctrl key and click to open the Computer subdocument.
15. In the first paragraph, locate and select Students that are physically handicapped
and even speech impeded students are afforded a safer place.
16. Select Intense Emphasis, and then Bold.
17. SAVE the subdocument and CLOSE .
18. Click the Show Document button to display the controls. You may need to switch back
to Outline view before performing this step.
19. Click the Expand Subdocuments button, and then select the plus (1) symbol for
Computer-Mediated Discussion Groups . Then place a check mark by Show First
Line Only.
20. Click the Move Up button until it is positioned below the continuous section break
below Community in the Classroom.
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21. Click the Show Document button.
22. Unlink the two subdocuments, and then create two separate subdocuments.
23. Click the Collapse Subdocuments button.
24. SAVE the document in the folder on your flash drive, and then CLOSE the file.
PAUSE. LEAVE Word open for the next project.

Project 3: Sharing Documents
You have prepared the Master Research document for sharing. You are now ready to share a section
of the document with one member of your group, and then you will share the whole document to
the group using the Present Online command.
GET READY. LAUNCH Word if it is not already running.
1. OPEN the Introduction document from the Master Research folder.
2. Click the File tab, and then click Account and sign-in.
3. Click Share, and then click Save To Cloud.
4. Click Save As and then click Sign In’s SkyDrive, and then click the Shared favorites
folder. Click Save.
5. Identify someone from your class and send this person an e-mail.
6. CLOSE the file.
7. OPEN the Master Research document.
8. Go to Backstage, click Share, and then select Present Online.
9. Send an invitation by e-mail to three individuals in class.
PAUSE. LEAVE Word open for the next project.

Project 4 : Creating a Simple Macro
You work with Tech Terrace Real Estate Agency and you are responsible for sending a follow-up
e-mail or letter to potential clients. Create a simple macro that can be used to follow up with
clients. Prepare the letter in a block format so that it can be used in Outlook or mailing. Test your
macro before sharing.
GET READY. LAUNCH Word if it is not already running.
1. Create a blank document.
2. Change the top margin to 2”.
3. Assign Alt1F as the keyboard command and save changes in the document.
4. Type the following information:
Good afternoon ,,first name..:
On a daily basis you receive emails from Tech Terrace Real Estate Agency listing the
available home sites. I just wanted to check in and see if anything looked appealing
and if you were interested in seeing any of the sites? Are the listings you receive still
meeting your search criteria?
Please let me know if there are any changes I should make on the site locations.
Best Regards,
Veronica
5. SAVE the document as Follow-up Letter in the lesson folder on your flash drive, and
then CLOSE the file.
CLOSE Word.

